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Notes 
 
Thank you for purchasing the “Universal Probe” from Sohwa & Sophia Technologies. Correctly 
understand notes and other information in this document before using this product. 
 
 
1. Permission from the Japanese government is required when exporting the product and 

technologies described in this document to which the “Foreign Exchange and Foreign Trade Act” 
applies to or bringing them out of Japan. 

2. The product described in this document is intended to be used for general electronics such as 
business equipment, communication equipment, measuring instruments, and home electric 
appliances. Do not use this product in special-purpose equipment such as automobile, railway, 
marine, or aerospace equipment, transportation equipment, combustion equipment, safety 
devices, medical equipment, infrastructure equipment, or nuclear power that requires special 
quality and reliability and of which failure or malfunction may directly threaten human lives or 
injure human bodies. The customer should be responsible for using this product in such 
equipment. 

3. It is strictly prohibited to reprint this document in whole or in part without our written 
permission. 

4. The contents of this document are subject to changes without notice. 
5. The specifications in this document may lead to different results depending on your environment 

or measurement conditions. 
6. Note that we bear no responsibility for consequence of operating this product. 
7. “Operating Precautions” in this document are important notes to prevent damage on users and 

third parties as well as assets and to use the product safely and correctly. Be sure to read these 
precautions before using this product. 

8. The product names and trade names in this document are trademarks or registered trademarks 
of respective owners. 

 
 
 
 
 

 
Contact information can be obtained on the website of Sohwa & Sophia Technologies Inc. 
URL > http://www.ss-technologies.co.jp/en/index.html 

 
 
 
 
 
 

http://www.ss-technologies.co.jp/en/index.html
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Operating Precautions 
 

 

Failure to observe the following precautions may lead to human death 
or severe injury. 

  

 
Do 

Avoid supplying voltage out of the range specified in the specifications of this 
product. 
Supplying the voltage out of the range may cause damage or fire. 

 
Do 

When using the target equipped with the ground terminal, ensure that the ground 
terminals of the target and peripheral equipment are connected. Failure to do so 
may cause an equipment failure or electric shock. 
Avoid connecting the ground terminal to the gas pipe. This causes a fire or 
explosion. 

 
Don't 

Do not transport this product with equipment connected. 
In particular, hold the plug when removing or inserting the cable. Failure to do so 
may damage the cable, causing a fire or electric shock. 

 
Don't 

Observe the following points when handling the cable. Do not damage, process, 
forcibly bend, twist, pull, putting any object on or heat the cable, moving the cable 
close to the heating device, or touch the cable with a wet hand. 
Failure to observe these precautions may cause a fire or electric shock. 
If the cable is damaged, stop using it. 

 
Don't 

When you hear thunders, do not touch the power plug. This causes an electric 
shock. 
If the product seems to be damaged by lightning strike, stop using it. 

 
Don't 

Do not let a staple, clip or other metal item enter into the product. This may cause a 
fire or failure. 

 
Don't 

Do not use or leave the product in direct sunlight, near heating devices, in an 
extremely hot or cold environment, under hard vibrations, in dusty area with a large 
amount of metal dust or oily dust, or noisy area full of spike noise. 
Do not apply a strong shock to the product. 

 
Do not 

disassemble 

Do not disassemble, alter or repair the product. This may cause a fire or electric 
shock. 

 
No wetting 

Do not use the product at a place where there is liquid or a humid place such as in 
the bathroom or in vicinity to glasses.  
This may cause an electric shock. 
If liquid enters into this product, immediately turn it off and stop using it. 

 
Caution 

Touching the energized product for a long time may cause low-temperature burns. 
Do not use this product covering with comforter or other cloth. 

 
Pull out the 

plug. 

Immediately turn the power off if unusual smell, noise, smoke or fire is detected or if 
the product is or may be damaged due to a fall or strong shock. Continuing to use it 
may lead to a serious accident. Stop using the product. 
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Abbreviations, Terms and Conventions 
This section describes the abbreviations, terms and conventions used in this document. 
 

 About numeric values ... All the numeric values are positive unless otherwise specified. 
 K (capital letter) ... Represents 210=1024. (Example: 16K=16384) 
 k (small letter) ... Represents 1000. (Example: 1kHz=1000Hz) 
 [xxxxx] ... Represents the window title. 
 <xxxxx> ... Represents the item in the window. 

 
 
 
The annotations and notes used in this document are as shown in Figure 1. 
 
 
 

 Information reference. 

 
 

 Supplementary information. 

 
 

 Caution. Be sure to read this. 

 
 

Figure 1 
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Abbreviations and terms are listed in Table 1. 
 

Table 1 

Abbreviations and terms Description 

This product Universal Probe including accessories. 

Probe Universal Probe itself. 

This software SPI Writer. 

Flash memory Generic term for flash memory, EEPROM, and other memories. 

Serial No. Stands for the serial number. Means the Probe ID. 

Software Code 
License required to issue the License Code for each software. Not 
required for the free edition. 

License Code Code to add the functions that can be used in this device. 

Module 
Data to be written to the flash memory. This includes object data and 
symbol data. 

Object data Binary data to be actually written to the flash memory. 

Symbol data 
Data that expresses the correspondence relationship between the 
variable or function name (=symbol) and the address. 

Host PC PC where this software runs. 

Target Object to be controlled or measured with the Universal Probe. 

Stand-alone function 
Ability to operate without connecting to the host PC. (The power 
supply is required.) 

(N/A) Stands for Not Assigned. Indicates that no information is assigned. 

PC PC stands for the Program Counter. 
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1. Overview of This Software 
This chapter provides an overview of this software. 
This software writes data in the “SPI flash memory”. 
Figure 2 shows differences in functionality and supported configuration from "ARM Writer," the 
software separately available. 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2 
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1.1. System Requirements 
 
The following systems are required to run this software. 
 

 PC running Microsoft Windows 7 or later 
 CPU: 1GHz or faster (depending on the requirements of the used OS) 
 Memory: 1GB or larger (depending on the requirements of the used OS) 
 HDD: 500MB or larger free hard disk space 
 OS: Windows 7 or later (32bit or 64bit versions are supported) 
 One or more empty USB 2.0 ports 

 

1.2. Characteristics 
 
This software has the following characteristics. 
 

 Saving and restoring the operating environment by using the project file 
 Download function to automatically recognize the format of written data 
 Support for multiple data writing operations 
 Flexible write processing realized by the batch function 

 
 
1.2.1. SPI Flash Memory Operation Functions 
 

 Fill-up function to write specific data in the specified address range 
 Search function to search the specified address range for a character string or data 
 Functions to save memory data to a file 
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1.3. Turning On or Off the Power 
 
1.3.1. Connecting to the Target and Turning On the Power 
 
Connect the probe and the target with the following procedure: 
 

1) Confirm that the target is turned off. 
2) Connect the USB cable of the probe. 
3) Connect the target and the probe. 
4) Turn on the target. 
5) Start this software and perform functions such as writing data. 

 
 
 
1.3.2. Turning Off the Power and Disconnecting from the Target 
 
Disconnect the probe from the target with the following procedure: 
 

1) Exit this software. 
2) Turn off the target. 
3) Remove the probe from the target. 

 
 

 
For details of the hardware specifications of probe, target restrictions, connection and other 
items, refer to the “Hardware Users Manual.” 
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2. How to Operate 
This chapter explains how to operate this software. 
 

2.1. Workflow 
 
The main processes from starting this software, writing the user module, through saving the project file 
are shown in Figure 3. For the operations not described here, refer to "2. How to Operate" or "4. Menu." 
 

Starting This Software 

↓ 

Selecting a Project File 

↓ 

Selecting a Probe 

↓ 

 Setting the SPI Flash Memory 

↓ 

Setting Probe Environment 

↓ 

Clearing the SPI Flash Memory 

↓ 

Writing Object Data 

↓ 

Saving the Project File 

 
Figure 3 
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2.2. Starting This Software 
 
Several methods are provided to start this software. 
 
 
2.2.1. Starting Methods 
 
● Method 1 
 
Double-click the icon for this software on the desktop. 
 
 
● Method 2 
 
Click “Start” Button → “All Programs” → “Universal Probe” → “Universal Probe SPI Writer” in the 
“Start” menu. 

 

 
Figure 4 
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● Method 3 
 
Double-click SPIWriter.exe or a project file (.spiwpj) in Explorer or other tools. 
 

 

Figure 5 
 
 
● Method 4 
 
Click “Start” → specify “SPIWriter.exe” or a project file (.spiwpj). 

 

 
Figure 6 
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The above operations start this software as shown in the figure below. 

 
Figure 7 
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2.3. Selecting a Project File 
 
This software always uses a project file (.spiwpj) to save the following settings. 
 

 Information on the module to be written 
 Settings of writing environment 

 
Writing new data requires creation of a project file. 
When the existing project file is opened, saved status can be restored. 
 
 
2.3.1. Creating a New Project File 
 
Let's create the TEST folder in the C:\SPI_Writer folder and create a project file named test. spiwpj, 
as an example. 
Click the following toolbar button or menu bar.  (Details of [Create New Project] dialog box) 
 
 
Tool button Operation on the menu bar Shortcut key 

 
File → New Project --- 

 
 
The [Create New Project] dialog box opens. 
 

 
Figure 8
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Create a folder to save the project file or select an existing folder. 
 
(1) Creating a folder 
 
Click the     button. 
 
The [Select Folder] dialog box opens. 
 

 

Figure 9 
 
Select C:\SPI_Writer and click the                button. 
 
The [Create Folder] dialog box opens. 
 

 
Figure 10 

 
Enter “TEST” in <Folder to create> and click the     button. 
 

 A space or slash cannot be included in the folder name. 

 
 
 
 
 
 
 
 

Browse 

Create Folder 

OK 
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Return to the [Folder] dialog box. 
 

 

Figure 11 
 
(2) Selecting a folder 
 
Select the created TEST folder and click the           button. 
Return to the [Create New Project] dialog box. 
 
(3) Specifying a project name 
 
Specify a project name (test) in <New Project>. 
This project name is used as the project file name and displayed in the <Location> box at the bottom 
of the dialog box. 

  
Figure 12 

 

 A space or slash cannot be included in the folder name. 

OK 
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2.3.2. Opening a Project File 
 
To open a saved project file, select the project file (.spiwpj) with the following operation. 
 
Tool button Operation on the menu bar Shortcut key 

 
File → Open Project --- 

 
 

 

The project file can be opened by double-clicking it in Explorer. 
Or, the project file can be opened by dragging and dropping it to the icon for this software on 
the desktop. 
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2.4. Selecting a Probe 
 
Select the probe to be used in this software. 
Click the     button in the [Create New Project] dialog box. 
The currently connected probes are listed in the [Selecting a Probe] dialog box. 
 

 

Figure 13 
 
Click the probe to be used and click the     button. 
 

Table 2 

Serial number Displays the serial number registered for the probe. 

Status Displays the status of probe. 

Connectable : The probe can be connected to this software and 
used. 

Currently used : The probe is already used in another application. 
This software cannot use this probe. 

License not registered : The license is not registered. 
To use this probe, click the                 
button to register the license. 

 

Connects to the selected probe. 
This button is enabled only when the probe of which status is “Connectable” 
is selected. 
After connection is established, the dialog box closes and the [Create New 
Project] dialog box is displayed again. 

 
Searches for the currently connected probes again and updates the probe 
list. 

 
Displays the dialog box to register the license. 
This button is enabled when the probe of which status is “Connectable” or 
“License not registered” is selected. 

 For details, refer to "2.5. Registering the License Code." 
 

 Closes this dialog box. Close 

Register License 

Update 

Connect 

Probe 

Connect 

Register License 
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2.5. Registering the License Code 
 
This software employs the license system. 
A separate Software Code is required to obtain the License Code. 
When a user notifies us the Software Code and probe Serial No., the License Code will be issued. 
 
 
(1) Entering the License Code 
 
When this software starts, select a probe for which [Select Probe] dialog box shows “License not 
registered” or “Connectable” and click                    button. The License Code entry window is 
displayed. 
Enter the License Code received from us. This software becomes usable at the target probe. 
 

 
Figure 14 

 
 
(2) Notes on entering the License Code 
 
Enter exactly the same License Code as the received information. 
 
 

 
If the License Code is rejected even though it matches the code in the received email, please 
contact us. 

 
 
 

Register License 
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(3) Error display list 
 

Table 3 

Displayed Error Meaning Action 

The License Code is incorrect. Displayed when the License 
Code cannot be analyzed due to 
invalid format of License Code 
or for other reasons. 

Check the email that includes 
the License Code and enter it 
again. 

The License Code does not 
match the serial number. 
Please check if the License Code 
is matching the Serial number 
of Probe. 

Displayed when the Serial No. of 
the used probe does not match 
the Serial No. of the probe to 
which the License Code is 
applied. 

Check the email that includes 
the License Code and enter it 
again. 
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2.6. SPI Flash Memory Settings 
 
Select the SPI device to be used by this software or load the configuration file (*.fsh) for the SPI flash 
memory. 
This dialog box configures the settings necessary for accessing the SPI flash memory. 
 

 
Figure 15 
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(1) Device information 
Table 4 

Select device Select this when making the SPI flash memory registered in this software an 
operation target. 

Manufacturer Select the manufacturer of the SPI flash memory registered in this software 
from the pull-down list. 

Size Select the size of the SPI flash memory registered in this software from the 
pull-down list. 
If the manufacturer is already selected, only the size of the SPI flash memory 
of the selected manufacturer will be shown in the pull-down list. 
To cancel the selection, select the blank area at the top of the pull-down list. 

Device Select the SPI flash memory device registered in this software from the pull-
down list. 
If the SPI flash memory device registered in this software can be determined 
uniquely by manufacturer and size, the device will be selected automatically. 
To cancel the selection, select the blank area at the top of the pull-down list. 

Specify file Select this when specifying the flash memory configuration file (*.fsh). 
The flash memory configuration file is a file that is created by the Memory 
command builder. 

File name Specify the configuration file (*.fsh) of the flash memory to be loaded. 
 
 
(2) I/O reference power supply 

Table 5 

Externally supplied Select this when the I/O power supply for the probe is supplied from the 
target through Vtref. 
It is set to ON by default. 

Internally generated Select this when the I/O power supply for the probe is not supplied from the 
target through Vtref. 
When this is selected, the I/O power supply uses the power generated within 
the probe. 

Voltage Use this to select the supply voltage to be generated within the probe from 
the pull-down list. 
This pull-down list becomes available only when [Internally generated] is 
selected. The default voltage is 1.2 V. 
Set this voltage in accordance with the interface voltage on the target side. 

Vtref power output: 
yes 

Power is supplied from the main unit to the target through Vtref. 
Select this when there is no power supply on the target side. 

Vtref power output: 
no 

Select when the I/O power supply to the probe is not supplied from the target 
through Vtref, despite there being a power supply on the target side. 
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 Refer to "Hardware Users Manual" for current values that can be supplied. 

 
 
(3) SPI flash memory settings 
 
When the        button is clicked, the settings for accessing the SPI flash memory will be configured 
in the probe. 
 
A message will be displayed when an error has occurred when registering a command script of the 
SPI flash memory. 
Please select whether to cancel the activation process of this software or to continue. 
SPI device settings can be changed after creating the project file, even if you select to continue. 
 

 
An error message appears if you manually edit the flash memory configuration file (* fsh) or 
when the versions of the flash memory configuration file and this software are different. 

 

OK 
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2.7. Setting Probe Environment 
 
The [Probe Setup] dialog box can be used to set the clock settings according to the used SPI flash 
memory. 
 

 
Figure 16 

 
 Specify a clock frequency and click the            button.  
 

Table 6 

Clock Select Specify the maximum clock frequency for the SPI flash memory. 
Selecting the Low-speed Clock allows specifying the frequency in the 
KHz. (up to 1000KHz) 

 
 

OK 
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2.8. Clearing the SPI Flash Memory 
 
When data is written to the SPI flash memory, the memory needs to be cleared before rewriting. 
Select the following menu and display the SPI Flash Memory Settings dialog box. 
When the SPI Flash Memory Settings dialog box is displayed already, select the “Clear” tab. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → SPI flash memory → Clear --- 

 
 

 
Figure 17 

 
(1) Clear 

Table 7 

Chip Erase Clears all of the SPI flash memory. 

Block Erase Clears one block of the SPI flash memory that includes the address entered in 
<Address>. 

 
 
(2) Start button 
 
When pressing the        button, the clear processing will start. 
 

Start 
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The progress is displayed during the clearing process. 
 

 
Figure 18 

 
The operation result is displayed when the clearing process is complete. 
 

 

Figure 19 
 
Check whether the specified area has been cleared normally in the Memory Dump Window. 
 

 
Figure 20 
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2.9. Writing Object Data 
 
Download object data to the set flash memory. 
Select the following menu item and display the [Download Settings] dialog box. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → Download --- 

 
Set the information on the module to be written in the [Download] dialog box and click the     
button. The progress dialog box is displayed during the download process. 
 

 
Figure 21 

 
 
Display the Memory Dump Window and confirm that the object data was downloaded in the flash 
memory. 
If the data was not downloaded, confirm the flash memory settings again. 
 
 

 When writing fails, Confirm that Clearing the Flash Memory was completed. 

 

 Up to 1KByte of object data can be downloaded in the size limited version. 

 

Download 
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2.10. Filling up the SPI Flash Memory 
 
Perform the fill-up processing for the SPI flash memory that has been set. 
Select the following menu and display the SPI Flash Memory Settings dialog box. 
If the SPI Flash Memory Settings dialog box is displayed already, select the [Fill-up] tab. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → SPI flash memory → Fill-up --- 

 
 

 
Figure 22 
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(1) Fill-up 
 

Table 8 
Range Start address:  

 Specify the address at which the fill-up to the SPI flash memory will start. 
End address:  
 Specify the address at which the fill-up to the SPI flash memory will end. 
Range length: 
 Specify the range from the start address. 

Fill-up Data Specify the data to be written to the SPI flash memory. 
Only byte-size data can be specified. 

Automatically execute 
chip erase before fill-up 

Execute chip erase automatically before performing the fill-up to the SPI 
flash memory. 
It is set to ON by default. 

 
 
(2) Start button 
 
When specifying the fill-up method and pressing the        button, the fill-up processing will start. 
When "Automatically execute chip erase before fill-up" is checked, chip erase will be executed before 
the fill-up. 
 
A dialog box showing the progress status will be displayed during the fill-up. 
 

 
Figure 23 

 
When the fill-up process is complete, the processing result is displayed of the dialog box. 
 

 

Figure 24 
 
Check whether the specified area has been cleared normally in the Memory Dump Window. 

Start 
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Figure 25 

 
 
 

2.11. Saving the Project File 
 
The project settings can be saved in the project file. 
Refer to "Save a Project." 
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2.12. Exiting This Software 
 
To exit this software, select the following menu item or click the X button at the right top of the 
window. 
 
Tool button Operation on the menu bar Shortcut key 

--- File → Exit --- 

 
When the [Exit] dialog box is displayed, select whether to save the project before exiting the 
software. 
 

 
Figure 26 

 
(1) Save Project File 
 
Overwrites the created project file in the current project file and exits the software. 
 
 
(2) Save Project As 
 
Saves the created project file as a different project file and exits the software. 
 
 
(3) Do Not Save 
 
Exits the software without saving the current project settings. 
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3. Data Expression in This Software 
This chapter describes how data is expressed in this software. 
 

3.1. Numerical Expression 
 
This software can handle numerical expressions in binary, decimal and hexadecimal. 
 

Table 9 

Format Radix Example 

0x<numerical value> Hexadecimal 0x12345678 

H'<numerical value> Hexadecimal H’12345678 

@<numerical value> Binary @01011101 

<numerical value> Decimal 12346578 
 
 

3.2. Address Expression 
 
This software expresses addresses by combining a format and operator shown in Table 9. 
 

 H'<numerical value> cannot be used. 

 
 

3.3. Data Expression 
 
This software expresses data by combining a format and operator shown in Table 9. 
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3.4. Reading SPI flash memoy 
 
To execute the ASSIGN or dot (.) command in the command window or read SPI flash memoy data 
with a conditional expression in the batch program, specify as follows: 
 

Table 10 

Expression Meaning 

[Address formula] or [Address formula].B Byte data at the specified address 

[Address formula].W Word (two-byte) data at the specified address 

[Address formula].L Long word (four-byte) data at the specified address 
 
● Example 

For the normal memory space, just enter the address. 

 

.[0x4000].B  // Refer to the byte data at address 0x4000. 

.[0x4000].W  // Refer to the word data at address 0x4000. 

.$A=[0x4000].L            // Assign four-byte data at address 0x4000 to work variable $A. 

if([0x4000].W==0x1234)    // True when the word data at address 0x4000 is 0x1234. 
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4. Menu 
This chapter explains the menus of this software. 
 

4.1. File 
 
The "File" menu item is used to operate the files related to the project. 
 
 
4.1.1. Close 
 
Closes the currently focused child window. 
This menu item cannot be selected if there is no child window. 
 
 
4.1.2. Create a New Project 
 
Creates a new project. 
When using for the first time, select the following tool button or menu item to create a project. 
The project is saved to a project file (.spiwpj). 
 
Tool button Operation on the menu bar Shortcut key 

 
File → New Project Ctrl + P 

 

 
Figure 27 
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Table 11 

New Project Specifies a project name. 

Probe Probe type : Type of probe 
Target : “SPI” is displayed. 
License : License type is displayed. 
 Size-limited → It is a license with 1KByte write size limit. 
 Available → It is a license without write size limit. 

 
Displays the [Select Probe] dialog box, and lists the currently connected probes. 
To select the probe to be used, click the probe name part and click the OK 
button. 

Location Displays the full path to the project file to save. 

 
The [Select Folder] dialog box is displayed. Select the folder where the project file 
is saved. 

 Creates a project file. 

 Aborts creation of a project file. 

 
 
 

Cancel 

OK 

Browse 

Probe(P)... 
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4.1.3. Open a Project 
 
Opens the saved project file. Restores the settings when you finished the last work. 
 
Tool button Operation on the menu bar Shortcut key 

 
File → Open Project Ctrl + R 

 
 
4.1.4. Save a Project 
 
Saves a variety of information currently set in the existing project file. 
 
Tool button Operation on the menu bar Shortcut key 

 
File → Save Project Ctrl + S 

 
 
4.1.5. Save as a Project 
 
Variety of information currently set is saved in another project file. 
 
ツールボタン メニューバーの操作 ショートカットキー 

--- File → Save Project As Ctrl + A 

 
 
4.1.6. Close a Project 
 
Closes the currently open project. 
The [Close Project File] dialog box is displayed before the project is closed. 
 
Tool button Operation on the menu bar Shortcut key 

--- File → Close Project --- 

 
 
4.1.7. Exit 
 
Exits this software. 
For details, refer to "Exiting This Software." 
 



 

40 / 131 
Universal Probe Software Users Manual – SPI Writer 

 

4.2. Resource 
 
The “Resource” menu is used to read/write data from/to the SPI flash memory. 
 
 
4.2.1. Download 
 
The [Download Settings] dialog box is used to set the module to be written and give the actual writing 
instruction. 
Multiple modules can be specified. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → Download --- 

 

 

Figure 28 
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Table 12 

Module list List of modules to be downloaded. 
Multiple files can be selected by holding down the Ctrl or Shift key. 

Format Select the object format of the module to be downloaded. 
Auto selection is selected by default. 
This item must be specified for each module when multiple modules are 
selected. 

Download object data Checkmark this checkbox when downloading object data. This item 
must be specified for each module. 

Download symbol 
information 

Not usable in this software. 

Download again at next 
start up. 

Automatically downloads the module when the project file is opened. 

Module information Display the module path, file size, and timestamp. 

 
Adds a module to be downloaded. 
The [Open File] dialog box is displayed. Select the module to be added 
in it. 
The added module is displayed in the module list. 

 Deletes the module selected in the module list. 

 
Downloads the selected module. 
The <Download object data> checkbox must be checkmarked. 
If multiple modules are selected in the module list, all the selected 
modules are downloaded. 

Automatically execute chip 
erase before download 

When this checkbox is ON, all the data in the flash memory is cleared 
before download. The memory is cleared only once for a single 
download operation. 
Even when multiple modules are selected and downloaded, the clear 
operation is executed only once. 

 
 

 

If memory access errors frequently occur when object data is downloaded, select the [Set a 
Probe Environment] and select <Enable verification>. 
When <Enable verification> is set, whether the memory was correctly written can be 
confirmed from this software. Verification is disabled by default. 

 
 

 Up to 1KByte of object data can be downloaded in the size limited version. 

 
 

Download 

Delete 

Add 
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4.2.2. Upload 
 
The upload function reads data from the SPI flash memory, converts to a variety of format, and saves 
to a file. 
Selecting the following menu item opens the [Upload] dialog box. 
To upload data, display the [Upload] dialog box and specify the memory range and format to be saved 
to a file. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → Upload --- 

 
 

 
Figure 29 
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Table 13 

File Format Select one of the following file formats. 
 

Format Memory 
range 

PC address 
specification 

Automatic 
recognition Remark 

Intel standard 
HEX 0 to 64KB Allowed Allowed  

Intel extended 
HEX 0 to 1MB Allowed Allowed 

Segment 
value is 
added. 

Intel 32bit HEX 0 to 4GB Allowed Allowed  
Motorola S type 
HEX (S1 - S9) 0 to 64KB Allowed Allowed  

Motorola S type 
HEX (S2 - S8) 0 to 16MB Allowed Allowed  

Motorola S type 
HEX (S3 - S7) 0 to 4GB Allowed Allowed  

High-speed 
download (SHF) 0 to 4GB Not allowed Allowed 

This is our 
proprietary 
format. 

Binary 0 to 4GB Not allowed Not 
allowed 

Uploads data 
as binary 
data. 

 

 

“Allowed” in the automatic recognition field indicates whether the 
format can be automatically recognized when this software 
downloads data. 

 

File name Specify the name of the file to save. 

Upload Address 
range 

Start address : Specify the start address. 
End address : Specify the end address. 
Length : Select and specify the end address or the range length. 

 Reads data from the SPI flash memory and saves to the specified file. 

 

Upload 
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4.2.3. Set a Probe Environment 
 
Set the probe environment. 
Selecting the following menu item opens the [Probe Environment Setup] dialog box. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → Probe Environment --- 

 

 

Figure 30 
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(1) Clock 
 
Set the maximum clock frequency of a SPI flash memory. 
 

 

Figure 31 
 

Table 14 

Specify JTAG clock 
frequency 

Select the maximum clock frequency of a SPI flash memory. 
* The low-speed clock frequency can be specified from 1 to 1000KHz. 
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(3) Switch 
 
Set the Endian. 
 

 

Figure 32 
 
 

Table 15 

Select Endian Big endian: The display of a [Memory Dump Window] is a big endian. 
Little endian: The display of a [Memory Dump Window] is a litle endian. 

 
 

 The default is Little endian. 
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(4) Polling 
 
Set the polling interval to monitor the SPI flash memory status. 
 

 

Figure 33 
 
 

Table 16 

Interval Set the polling interval to 100ms. 
The valid range is from 100ms to 4,294,967,200ms. 

Use as preset value The set value becomes the preset value and used for subsequent 
projects. 

 Restores the default value (500ms). 

 Restore the value set as a preset value. 

 
 
 
 

Restore Preset Value 

Restore Default Value 
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4.2.4. Set Batch File Automatic Execution 
 
Set the timing to automatically execute a batch program. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → Auto Execute Batch Select --- 

 
 

 

Figure 34 
 
 

Table 17 
At startup 
(before loading the project) 

Execute a batch file when starting this software (before loading the 
project). 
This makes it possible to execute necessary processing in batch before 
loading various settings, window information and other data to avoid 
accessing an invalid memory or other problems. 

Batch file name: {project name}.sta 
At startup 
(after loading the project) 

Execute a batch file when starting this software (after loading the 
project). 

Batch file name: {project name}.fst  
 
Pressing the button on the toolbar executes a batch file named as follows: 
Batch file name: {project name}.wrt 
 
Tool button Operation on the menu bar Shortcut key 

 
--- --- 

 
 

 Save batch files in the same folder as the project file. 
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4.2.5. Memory Search 
 
Searches the specified range of memory and shows the addresses containing data that matches or 
does not match the specified data. 
Numerical values or ASCII character strings can be specified as the search data. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → Memory Search --- 

 
 

 
Figure 35 

 
(1) Search Address Range 
 
Set the address range over which a memory check is conducted. 
 

Table 18 

Start address Specify the start address. 

End address Specify the end address. 

Length Specify the range length. 
 



 

50 / 131 
Universal Probe Software Users Manual – SPI Writer 

 
(2) Search Data 

Table 19 

Data value 
 

Specify data to search for. 
To search for data that does not match the specified data, prefix the search 
data with an exclamation mark (!). 
You cannot search for data that does not match a character string. 
Numerical value: 0x34, 128, !0x56, etc. 
ASCII character string: ”abcdef,” ”ghijk,” etc. 

Data Size Specify the size of data to search for. 
 
 
(3) Search Result 
 
Shows the addresses retrieved by a memory search. 
The result also appears in the Command window. 
 

 
Figure 36 
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4.2.6. SPI flash memory 
 
 

 

For details, refer to "4.4. SPI Flash Memory." 

 
 



 

52 / 131 
Universal Probe Software Users Manual – SPI Writer 

 

4.3. Go 
 
There are the following commands in "Go" menu. 
 
 
4.3.1. Cancel 
 
Abnormal operation in the target, an attempt to access an area that cannot be accessed, or other 
unexpected or illegal operations may disable communication between the host PC (and the probe) and 
the target. 
Executing this command may restore communication between them. However, even if communication 
could be restored, you should save the project file and restart all the systems since it is often the case 
that such a communication problem cannot be controlled properly. 
 
Tool button Operation on the menu bar Shortcut key 

--- Go → Cancel --- 

 
 
 
4.3.2. Verify (Compare When Writing) 
 
If writing is executed with this menu item checkmarked, verification is conducted after writing. 
 
Tool button Operation on the menu bar Shortcut key 

 Go → Verify (Compare When Writing) --- 

 
 
 
4.3.3. Verify Only (Compare Without Writing) 
 
If writing is executed with this menu item checkmarked, verification is conducted without writing. 
 
Tool button Operation on the menu bar Shortcut key 

 Go → Verify Only (Compare Without Writing) --- 

 
 



 

53 / 131 
Universal Probe Software Users Manual – SPI Writer 

 
4.3.4. Calculate Checksum Value 
 
Whether a module could be written to the flash memory of the target or not can be checked by 
calculating and comparing the checksums of the module to be written and the data in the flash 
memory. 
 

 
Figure 37 

 
Table 20 

Checksum in the Data Show the checksum of the data to be written to the flash memory. 
If no writing procedure has been registered, nothing is displayed. 

Checksum in the target 
memory 

Show the checksum of the data written to the flash memory. 
If no writing procedure has been registered, nothing is displayed. 

Ranges Show the address range of the data to be written to the flash memory. 
If no writing procedure has been registered, "None" is displayed. 

 
Calculates the checksums of the data to be written to the flash memory 
and the data written to the flash memory. If no writing procedure has 
been registered, "None" is displayed. 

 
 
 

 
In order to use this function, a writing procedure must have been registered in the probe. 
For details about registration of a writing procedure, refer to "9. Stand-alone Functions." 

 
 
 
 
 
 

Calculate 
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4.4. SPI Flash Memory 
 
 
4.4.1. SPI Flash Memory Settings dialog box 
 
The SPI Flash Memory Settings dialog box performs operations related to the SPI flash memory. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → SPI flash memory → Device settings --- 

 
The following three operations can be performed by switching between tabs on the upper part of the 
dialog box. 
 

1) Changing the SPI flash device 
2) Clearing the SPI flash memory 
3) Filling up the SPI flash memory 

 
 
4.4.2. Device tab 
 

 
Figure 38 
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(1) Device information 
 
The contents set at the time of activation of this software are displayed. 
The device information cannot be changed immediately after this dialog box is activated. 
When making changes to the device information, it is necessary to make changes after pressing the 
          button. 

 
Table 21 

Change Click this button to make changes to the SPI device information. 
The button turns into a Cancel button while changes are made. 

Apply This button becomes active while changes are made to the SPI device 
information. 
Click this button to change the probe settings for accessing the SPI flash 
memory. 

Select device Select when using the SPI flash memory registered in this software. 

Manufacturer Select the manufacturer of the SPI flash memory registered in this software 
from the pull-down list. 

Size Select the size of the SPI flash memory registered in this software from the 
pull-down list. 
If the manufacturer is already selected, only the size of the SPI flash memory 
of the selected manufacturer will be shown in the pull-down list. 
To cancel the selection, select the blank area at the top of the pull-down list. 

Device Select the SPI flash memory device registered in this software from the pull-
down list. 
If the SPI flash memory device registered in this software can be determined 
uniquely by manufacturer and size, the device will be selected automatically. 
To cancel the selection, select the blank area at the top of the pull-down list. 

Specify file Select this when specifying the flash memory configuration file (*.fsh). 
The flash memory configuration file is a file that is created by the Memory 
Command Builder. 

File name Specify the configuration file (*.fsh) of the flash memory to be loaded. 
 

Change 
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(2) I/O reference power supply 

Table 22 

Externally supplied Select this when the I/O power supply for the probe is supplied from the 
target through Vtref. 
It is set to ON by default. 

Internally generated Select this when the I/O power supply for the probe is not supplied from the 
target through Vtref. 
When this is selected, the I/O power supply uses the power generated within 
the probe. 

Voltage Use this to select the supply voltage to be generated within the probe from 
the pull-down list. 
This pull-down list becomes available only when [Internally generated] is 
selected. The default voltage is 1.2 V. 
Set this voltage in accordance with the interface voltage on the target side. 

Vtref power output: 
yes 

Power is supplied from the main unit to the target through Vtref. 
Select this when there is no power supply on the target side. 

Vtref power output: 
no 

Select when the I/O power supply to the probe is not supplied from the target 
through Vtref, despite there being a power supply on the target side. 

 
 

 Refer to "Hardware Users Manual" for current values that can be supplied 

 
 

 
The settings of the I/O reference power supply will be configured in the main unit when 
clicking the OK button on the dialog box. 

 
 
 
4.4.3. Clear tab 
 
 

 For details, refer to "2.8. Clearing the SPI Flash Memory." 

 
 
4.4.4. Fill-up tab 
 
 

 For details, refer to "2.10. Filling up the SPI Flash Memory." 
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5. Windows 
This chapter explains the windows of this software. 
 

5.1. Docking of Windows 
 
Child windows of this software can be docked at the top, bottom, right or left edge of the main 
window or placed outside the main window. 
 

 

Figure 39 
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5.1.1. State of Windows 
 
(1) MDI child windows (standard windows) 
 
These are windows that can be moved or scaled freely within the main window of this software. 
Each window of this software is opened in this state. 
 

 
Figure 40 

 
MDI child windows cannot be moved out of the main window.  
 

 
Figure 41 

 

The part outside of the main window is hidden. 
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(2) Docked windows 
 
These are windows that are docked at the top, bottom, right or left edge of the main window. (see the 
figure below). 
Docked windows can also be scaled. A docked window can be moved and docked at another edge. 
 

 
Figure 42 

  
(3) Floating windows 
 
Floating child windows can be moved out of the main window. 
However, flowing windows are also closed automatically when this software is exited or the project is closed. 
 

 
Figure 43 

 

The floating window is moved out 
of the main window. 
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5.1.2. Changing the State of a Child Window 
 
To change the state of a child window, right-click on the title bar of that window. 
This will show the context menu as shown below. Then, specify the desired state or the position to 
which it is to be docked. 
 

 

Figure 44 
 
 
Figures of the menu and descriptions of the menu items are shown below. 
 

Table 23 

Menu shown by right-click 
Menu shown by selecting 

"Docked to" 
Menu shown by selecting 

"MDI Child as" 
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Table 24 

Menu item Description 

Docked 
Docks the child window. 
The edge at which the window is docked is switched among four edges in 
the order of top, left, bottom and right. 

Floating Makes the child window floating. 

MDI Child 
Makes the child window an MDI child window. 
If the child window is floating and placed outside the main window, it is 
automatically moved back inside the main window. 

Docked to 

Top Docks the child window at the top edge of the main window. 

Left Docks the child window at the left edge of the main window. 

Bottom Docks the child window at the bottom edge of the main window. 

Right Docks the child window at the right edge of the main window. 

MDI Child 
as 

Minimized Makes the child window an MDI child window and minimizes it (into an icon). 

Maximized Makes the child window an MDI child window and maximizes it. 

Restored 
Makes the child window an MDI child window and displays it in the standard 
size. 
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5.1.3. Changing the Docking State by Drag-and-Drop 
 
(1) Changing the docking edge 
 
A docked or floating child window can be docked at another edge by the method in "5.1.2. Changing 
the State of a Child Window" or by dragging and dropping the title bar of the child window. 
Dragging the title bar of the child window to the desired edge of the main window changes the shape 
of the frame. Then, dropping it changes the location. 
 

 
Figure 45 

 

 
Figure 46 

 



 

63 / 131 
Universal Probe Software Users Manual – SPI Writer 

 
 
(2) Changing the state of window between docked and floating 
 
Dragging a docked child window outside or near the center of the main window changes the state of 
child window to floating. 
Dragging and dropping a floating child window near an edge of the main window changes the state of 
the child window to docked. 
 

 
Figure 47 

 
  
(3) Changing to an MDI child window 
 
A docked or floating child window cannot be changed to an MDI child window by drag-and-drop. To 
change to an MDI child window state, right-click on the title bar of the child window and select "MDI 
Child" from the displayed context menu. 
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5.1.4. Docking Two or More Child Windows at the Same Edge 
 
When two or more child windows are docked at the same edge of the main window, they can be 
displayed in the following two states: 
 

1) State when docked inside of the an already docked child window 
2) State when two or more child windows docked on one edge (docked edge) of the main 

window 
 
The figure below shows an example of (1). 
 

 

Figure 48 
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The figure below shows an example of (2). 
 

 
Figure 49 

 
 
5.1.5. Changing the Size of a Docked Window 
 
The size of a docked child window is changed by dragging the frame around the child window with the 
mouse cursor. 
 

 

Figure 50 
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5.2. Memory Dump Window 
 
This window is used to dump and display the contents of memory. Two or more Memory Dump 
Windows can be opened and they have the following characteristics: 
 

 The data in the specified range of memory is displayed. 
 Data can be displayed in various formats. 
 Data can be displayed in 1-, 2- or 4-byte signed/unsigned integer format. 
 Data can be displayed in 1-, 2- or 4-byte hexadecimal format. 
 Data can be displayed in 4-, 8, 10- or 12-byte real number format. 
 Read data containing changes from the previous values are displayed in red to make it easily 

identifiable. 
 The displayed data can be output in CSV format or text format. 

 
 
Tool button Operation on the menu bar Shortcut key 

 View → Memory Dump Window --- 

 
The size of the address view, data view, and character string view display areas can be changed by 
dragging the border line with the mouse. 
 
 
 

 
 
 
 

Figure 51 
 
 
 

Dialog Bar 

Character string view Data view Address view 
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Table 25 

Address Indicates the address from which data is displayed. 

End Address, Length Indicates the end address or the range to be displayed. 
Pressing the Enter key after entering a value displays the contents in 
the specified memory range. 

 (Display button) 
Reads the range specified by <Address> - <End Address> or <Range 
Length> again. If the data read again contains changes from the 
previous value, the value in the data view is displayed in red. 

 (Display of the 

context menu) 

Shows the context menu from which [Address Format], [Data Format], 
and [Access Size] are changed. 

 
When this is checkmarked, the displayed content is not updated if read 
again with the display button. 

Data Shows the data at the cursor position. 
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5.2.1. Context Menu of the Memory Dump Window 
 
Right-clicking on the area where data is displayed shows the context menu, from which the display 
format can be selected or data copied. 
 

 

Figure 52 
 
 

Table 26 

Address Format 
 

Change the format of the addresses displayed. 
Physical Address Display 

Data Format 
 

Change the display format of the memory data. 
Signed 1-byte integer 
Signed 2-byte integer 
Signed 4-byte integer 
Signed 8-byte integer 
Unsigned 1-byte integer 
Unsigned 2-byte integer 
Unsigned 4-byte integer 
Unsigned 8-byte integer 
1-byte hexadecimal number 
2-byte hexadecimal number 
4-byte hexadecimal number 
8-byte hexadecimal number 
4-byte real number 
8-byte real number 
10-byte real number 
12-byte real number 

Save to File The [Save to File] dialog box appears. The output formats are CSV 
and text. Options can be specified for CSV format. 
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Copy Data Copies the character strings in the selected range in the data view to 
the clipboard. 
* The character strings can also be copied by entering Ctrl + C from 
the keyboard. 

Copy String Copies the character strings in the selected range in the character 
string view to the clipboard. 
This item is enabled only when the character string view is displayed. 

Copy Address and Data Copies the character strings in the selected ranges in the address view 
and data view to the clipboard. 

Copy Address, Data and 
String 

Copies the character strings in the selected ranges in the address 
view, data view, and character string view to the clipboard. 
This item is enabled only when the character string view is displayed. 

Copy Data and String Copies the character strings in the selected ranges in the data view 
and character string view to the clipboard. 
This item is enabled only when the character string view is displayed. 

 
 
(1) [Save to File] dialog box 
 

 
Figure 53 

 
 

Table 27 

File name Saves the file having the specified name (If CSV Format is selected, add the 
extension ".CSV").  

Output File 
Format 

Either CSV Format or Text Format can be selected. 

Option Select the numeric number format. 
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(2) Selecting an area 
 
Displayed value can be selected by using the mouse or keyboard. 
 

 
Figure 54 

 
Table 28 

Selecting an area by using 
the mouse 

Dragging and dropping in the data view selects that range. 

Selecting an area by using 
the keyboard 

Holding the Shift key down and moving the cursor over a range in the 
data view selects the range. 

Deselecting a range A selected range is deselected by left-clicking the mouse or moving the 
cursor from the keyboard on the data view. 
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(3) Copying to the clipboard 
 
Select a range and "Copy (item)" from the context menu, and the data in the selected range will be 
copied to the clipboard. 
Entering "Ctrl + C" from the keyboard functions as "Copy Data." 
 

Table 29 
Copy Data 6b f7 1b d6 71 cc 77 4c b1 35 71 46  

c3 e2 31 28 b2 54 63 5c 12 ca d3 f3 03 f0 9f ad  

36 9e 43 3f d0 2d 47 ef b1 1d f4 80 43 0e 83 64  

47 c4 3c 0a b1 1e 11 4e 

Copy String k・ﾖ q ﾌ wL ｱ 5qF 

ﾃ・(ｲ Tc\.ﾊﾓ・ｭ 

6 曚?ﾐ-G・.C.ヅ 

G ﾄ<.ｱ..N 

Copy Address and Data R;0x00a205e0|            6b f7 1b d6 71 cc 77 4c b1 35 71 46  

R;0x00a205f0|c3 e2 31 28 b2 54 63 5c 12 ca d3 f3 03 f0 9f ad  

R;0x00a20600|36 9e 43 3f d0 2d 47 ef b1 1d f4 80 43 0e 83 64  

R;0x00a20610|47 c4 3c 0a b1 1e 11 4e 

Copy Address, Data and 
String 

R;0x00a205e0|            6b f7 1b d6 71 cc 77 4c b1 35 71 46 | k・ﾖ q

ﾌ wL ｱ 5qF 

R;0x00a205f0|c3 e2 31 28 b2 54 63 5c 12 ca d3 f3 03 f0 9f ad |ﾃ・(ｲ

Tc\.ﾊﾓ・ｭ 

R;0x00a20600|36 9e 43 3f d0 2d 47 ef b1 1d f4 80 43 0e 83 64 |6 曚?ﾐ-

G・.C.ヅ 

R;0x00a20610|47 c4 3c 0a b1 1e 11 4e                         |G ﾄ<.

ｱ..N  

* The data lines are wrapped around at the right edge. 

Copy Data and String             6b f7 1b d6 71 cc 77 4c b1 35 71 46 | k・ﾖ q ﾌ wL ｱ 5qF 

c3 e2 31 28 b2 54 63 5c 12 ca d3 f3 03 f0 9f ad |ﾃ・(ｲ Tc\.ﾊﾓ・ｭ 

36 9e 43 3f d0 2d 47 ef b1 1d f4 80 43 0e 83 64 |6 曚?ﾐ-G・.C.ヅ 

47 c4 3c 0a b1 1e 11 4e                         |G ﾄ<.ｱ..N  
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5.2.2. Displaying Multiple Memory Dump Windows 
 
Every time the following tool button is clicked, a new Memory Dump Window is opened. 
 
Tool button Operation on the menu bar Shortcut key 

 View → Memory Dump Window --- 

 
 

 

Figure 55 
 
 

 
By displaying two windows having the same address range and checkmarking the <Do Not 
Update> checkbox in one of them, you can compare the changes in the memory contents. 
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5.3. Command Window 
 
This window is used to for command line entry. This window has the following characteristics. 
 

 The keyboard- and mouse-based associative selection method allows quick command 
operations. 

 This window has the ability to display command execution results and log the commands. 
 Automatic execution with a batch function is supported. 
 The function to create a batch file is supported. 

 
 
The Command window can be opened by clicking the following tool button. 
 
Tool button Operation on the menu bar Shortcut key 

 View → Command Window --- 

 
 

 

Figure 56 
 
 
 

 For details about how to enter commands, refer to "7. Command Line Interface." 

 
 
The status bar shows the current CPU status, the status of different measurement functions, and 
guidance of the command line interface. 
 
Character strings copied to the clipboard can be executed as a batch file. Right-click on the command 
input area to open the context menu and select "Paste Batch," or place the mouse cursor on the 
command input area and enter "Ctrl + B." 

Status bar 
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6. Keyboard 
This section explains the keyboard operations that are non-standard on Windows keyboard. 
 

6.1. Memory Dump Window 
 
In the Memory Dump Window, the following keyboard operation is possible. 
 

 
 … Moves the cursor in Data view and Character String view. 

 
 

6.2. Command Window 
 
In the command window, the following keyboard operation is possible. 
 

 
 … Switches the display of command name and parameter name, and 

refers to parameters that were input in the past. 
 

… Confirms command and parameter. 
 

… When a command is being input, cancels one command or parameter. 
When a command is not input, performs forced break. 

 
… Confirms and executes the command. For omitted parameters, previously input parameters 

are set. 
 

↑ ↓ ← → 

↑ ↓ ← → 

Space 

ESC 

Return 
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7. Command Line Interface 
This section explains how to input and operate commands in the command window. 
Commands are input on the command line shown in Figure 57. 
 

 

Figure 57 
  

7.1 Operation on the Command Line  
 
Even if you do not remember command names or parameter names, entering the first few characters 
of a command or parameter displays the corresponding command names and parameter names to 
choose from, allowing easy input of command and parameter names. 
 
 
7.1.1. Command Input Method 
 
Click the command line to move the focus. 
By inputting a command and pressing the Return key, the command is executed. 
Some parameters can be omitted. The previously entered contents are applied to omitted parameters. 
 
 
7.1.2. Command Input by Associative Selection Method 
 
As you proceed with entry of command, the commands that are displayed in the command list 
according to the entered characters are narrowed down. 
By pressing the Space key, you can enter the command or parameter highlighted in green to the 
command line. 
Also, you can enter a command by selecting it from the command list with the mouse. 
The command list scrolls as you click the buttons. 
When placing the mouse cursor on the command list, a tool tip shows a brief explanation of the 
command. 
 

<< < > >> 

Command 
Line 

Command 
List 
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7.1.3. Entering Command from History 
 
By pressing the key on the command line you can display the command history. 
By selecting the command you want to execute from the history and pressing the Return key, you can 
re-execute the past command. 
 
 

 

Double-byte characters cannot be entered on the command line. 
Entry of the space character is not accepted in file path specification. Therefore, folder 
names containing the space character cannot be used. 

 
 

↑ 
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7.2. Explanation of Commands 
 
 
7.2.1. ASSIGN and Dot (.) (Evaluation of Formula) 
 
This command is used to evaluate formulas specified by parameters. 
By using this command, you can refer to and change the memory, I/O data or register data. 
 
●Format 
 
 
 
 
 
 
 
 
 

Figure 58 
 
●<Formula> 
 
Specify the formula to be evaluated. 
 
● Example 
 

Table 30 

.[0x4000].B Refer as 1-byte data to address 0x4000. 

.[0x4000].W Refer as 2-byte data to address 0x4000. 

.[0x4000].L Refer as 4-byte data to address 0x4000. 
 
 

 For details, refer to "3.2. Address Expression" and "3.4. Reading SPI flash memoy." 

 
 

 
If you use dot, the corresponding command is not recorded in the history in the command 
window. 

 
 

<Command> 

ASSIGN 

. (dot) 

<Formula> 

<Formula> 

or 
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7.2.2. BATCH (Execution of Batch Program) 
 
This command is used to execute the specified batch program. 
For details of batch program, refer to [Batch Function]. 
 
●Format 
 
 
 
 
 
 
 
 
 

Figure 59 
 
●<Batch file name> 
 
Specify the batch program file name. 
 
 
●<Argument> 
 
Specify the argument to be passed to the batch program. 
Separate each argument with the space character. 
Arguments are set to $1 to $9 in the batch program. 
$0 represents the whole command. 
Tenth and further arguments are ignored. 
 
 

<Command> 

BATCH <Batch file name> <Argument> 

Separation 
by space 
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7.2.3. CD (Change of Folder, Change of Drive, Display of Current Path) 
 
This command is used to move the work folder to the specified path. 
If the folder is not specified, the current work folder is displayed. 
 
●Format 
 
 
 
 
 
 

Figure 60 
 
●<Path name> 
 
Specify the path name to change. 
 
 
● Example 
 
[Display when the folder name is specified] 
Displays the work folder after move. 
 

 

Figure 61 
 
[Display when the folder name is omitted] 
Displays the current work folder. 
 

 
 

Figure 62 
 

 
File names and folder names need to be specified in the "8 characters.3 characters" format 
of the former DOS specification. 

 
 
 

CD <Path name> 

<Command> 
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7.2.4. CLOSE (Close the Project File) 
 
This command is used to close the project file that is currently open. 
When this command is executed, a confirmation dialog box is displayed. 
To close without displaying the confirmation dialog box, use the EXIT command. 
 
●Format 
 
 
 
 
 
 

Figure 63 
 
 
 
 

CLOSE 

<Command> 
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7.2.5. CLS (Clear the Command Window) 
 
This command is used to clear the command window that is currently open. 
 
●Format 
 
 
 
 
 
 
 

Figure 64 
 
 
 
 
 

<Command> 

CLS 
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7.2.6. DIR (Refer to the Folder Contents) 
 
This command is used to refer to the contents of the specified path. 
If the path is not specified, the contents of all files in the current work folder are displayed. 
This command has the same function as DIR command of DOS. 
 
●Format 
 
 
 
 
 
 

Figure 65 
 
●<Path name> 
 
Specify the path name to refer to. 
 
● Example 

 
Figure 66 

 

DIR <Path name> 

<Command> 
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7.2.7. DUMP (Dump Memory) 
 
This command is used to display the memory data in the specified address range in the specified 
display format. 
This command has the same function as operation in the Memory Dump Window. 
 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 67 
 
 
 
 
 
 

DUMP Start address LENGTH 

TO 

Range length 

End address 

FORMAT 

ASIZE 

4BYTE 

8BYTE 

12BYTE 

10BYTE 

HEX 

DEC 

UDEC 

REAL 

BYTE 

WORD 

LWORD 

BYTE 

WORD 

LWORD 

<Command> 

<Mode> <Display format> <Display size> 

<Access Size> 

<Address range> 
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<Range of start address value> 

Table 31 

Start address Specify the start address of memory to dump. 

Range length Specify the length from the start address in bytes. 

End address Specify the end address. 
 
 
●<Mode> 

Table 32 

FORMAT Specify the display format. 

ASIZE Specify the access size. 
 
 
●<Display format> 

Table 33 

HEX Displays in hexadecimal number. 

DEC Displays in decimal number. 

UDEC Displays in unsigned decimal number. 

REAL Displays in real number. 
 
 
●<Display size> 

Table 34 

BYTE Displays in byte size. 

WORD Displays in word size. 

LWORD Displays in long word size. 

4BYTE Displays in 4-byte real number format.  Example) -1.073726E+008 

8BYTE Displays in 8-byte real number format.  Example) -9.255963134931E+061 

10BYTE Displays in 10-byte real number format.  Example) -
4.7798665708109333850E+0986 

12BYTE Displays in 12-byte real number format.  Example) -
4.761268151994454601E+0986 
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7.2.8. ENV (Set the Probe Environment) 
 
This command is used to specify various probe environment settings. 
After the command is executed, the current setting status is displayed. 
This command has the same function as the following menu. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → Probe Environment --- 

 
 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 68 
 
JTAGCLOCK 
Specify the frequency of SPI flash memory clock. 
 

Table 35 

SLOWCLOCK Set specific frequency by the following parameter. Enter numeric value only 
assuming the unit of KHz. 

Frequency 
selection 

Specify a value in the range between 1 and 1,000. 

 
 
ENDIAN 
Specify the endian. 
 

Table 36 

BIG Set the big endian. 

LITTLE Set the little endian. 
 
 
 

ENV 

<Command> 

ENDIAN 

Clock value 

LITTLE 

BIG 

JTAGCLOCK 
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7.2.9. ERROR_ECHO (Set Error Message Display) 
 
This command is used to specify the display method of error message. 
 
●Format 
 
 
 
 
 
 
 
 
 

Figure 69 
 
●<Setting> 
 

Table 37 

OFF Displays error messages in the message box. 

ON Displays error messages in the command window. 
 
 
 
 

ERROR_ECHO OFF 

<Command> 

ON 

<Setting> 
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7.2.10. EXIT (Exit This Application) 
 
Exit this software. 
This command has the same function as the following operation. 
 
Tool button Operation on the menu bar Shortcut key 

--- File → Exit --- 

 
 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 70 
 
●<Mode> 
 

Table 38 

SAVE Saves (overwrites) the contents of the project to the current project file and exits 
the software. 

SAVEAS Saves the contents of the project to a project file under a different name and exits 
the software. 

NOTSAVE Exits the software without saving the contents of the project to a project file. 
 
 
●<File name> 
 
Enter the name of the file to save. If a file name only is specified, the file is saved in the current work 
folder. 
 
 
 

EXIT SAVE 

<Command> 

SAVEAS 

NOTSAVE 

<Mode> 

<File name> 
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7.2.11. FM (Set the SPI Flash Memory) 
 
This command is used to set the SPI flash memory. 
This command has the same function as the following operation. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → SPI flash memory → Device settings --- 

 
 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 71 

FM DEVICE <Device 
name> 

IOREFPWR 

<I/O reference power supply> <Command> 
 EXTERNAL 

FILE <File name＞ 

1.2V 

<Type> 

DISABLE 

ENABLE 

INTERNAL 

1.5V 

1.8V 

2.5V 

3.3V 

5.0V 

VTREFOUT 

< Voltage > < Vtref power output > 
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●Type 

Table 39 

DEVICE Specify the SPI flash memory device registered in this software. 

FILE Specify the configuration file (*.fsh) of the flash memory. 
 
 
●<Device name> 
 
Specify the SPI flash memory device registered in this software. 
 
 
●<File name> 
 
Specify the configuration file (*.fsh) of the flash memory. 
When a space is contained in a path, please enclose and input with a double quotation mark ("). 
 
 
●<I/O reference power supply> 
 

Table 40 

EXTERNAL Select this when the I/O power supply for the probe is supplied from the target 
through Vtref. 

INTERNAL Select this when the I/O power supply for the probe is not supplied from the 
target through Vtref. 

 
 
●<Voltage> 
 
Use this to select the supply voltage to be generated within the probe. 
 
 
●<Vtref power output> 
 

Table 41 

ENABLE Power is supplied from the main unit to the target through Vtref. 

DISABLE Select when the I/O power supply to the probe is not supplied from the target 
through Vtref, despite there being a power supply on the target side. 
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7.2.12. FMCLEAR (Clear the SPI Flash Memory) 
 
This tab is used to clear the contents of flash memory. 
This command has the same function as the following operation. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → SPI flash memory → Clear --- 

 
 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 72 
 
●<Mode> 
 
Specify the clear mode. 
 

Table 42 

ALL Clears all of the SPI flash memory. 

BLOCK Clears one block of the SPI flash memory that includes the address entered in 
<Address>. 

 

FMCLEAR ALL 

<Command> 

BLOCK <Address> 

<Mode> 
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7.2.13. FMFILL(Fill-up the SPI Flash Memory) 
 
This command is used to fill the SPI flash memory data in the specified address range with the speci 
fied data. 
After the command is executed, the execution result is displayed. 
This command has the same function as the following menu. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → SPI flash memory → Fill-up --- 

 
 
●書式 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 73 
 
●＜Address range＞ 

Table 43 

Start address Specify the start address of memory to fill. 

Range length Specify the length from the start address in bytes. 

End address Specify the end address. 
 
 
●＜Fill data＞ 
 
Fills up the memory with the data specified here. 
 
 
●＜Chip erase＞ 

Table 44 
ENABLE Execute chip erase automatically before performing the fill-up. 

DISABLE Not Execute chip erase automatically before performing the fill-up. 
 

FMFILL Start Address LENGTH 

TO 

Range length 

End Address 

Data 

<Fill data> 

<Address range> 
<Command> 

FMCLEAR 

DATA 

DISABLE 

ENABLE 

<Chip erase> 
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7.2.14. LOAD (Load the Object Data) 
 
This command is used to download the object data of the specified file. 
In the reload mode, files in the specified download list are downloaded again. 
In the delete mode, the file having the specified list number is deleted from the download list. 
This command has the same function as the following menu. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → Download --- 

 
 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 74 
 
●<Mode> 
 
Specify the download mode. 
 

Table 45 

OBJECT Downloads the specified object data file. 

RELOAD Downloads again from the file of the specified number. 

DELETE Deletes the file having the specified number from the download list. 
 
 
●<File name> 
 
Specify the name of the object data file to download. 
 
 

LOAD OBJECT 

<Number> 

DELETE 

<Command> <Mode> 

RELOAD 

<Number> 

<File name> <Format> 

FMCLEAR 
DISABLE 

ENABLE 

<Chip erase> 
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●<Number> 
 
Specify the number starting from 1 that are registered in the module list. 
You can check the number with the LOAD parameter of the QUERY command. 
 
 
●<Format> 
 
Specify the format name of the file to download. 
Normally, specify AUTO. 
The format names that can be specified are as follows: 
 

Table 46 

Format name Summary 

AUTO Automatically recognizes the file format. 

COFF Specifies COFF format. 

ELF Specifies ELF format. 

IHEX Specifies Intel HEX format.  

MHEX Specifies Motorola HEX format. 

SHF Specifies the original high-speed download format. 

SAUF Specifies SAUF format. 

BINARY <start address> Downloads from <start address> as binary data. 
 
 
●＜Chip erase＞ 

Table 47 
ENABLE Execute chip erase automatically before performing the download. 

DISABLE Not Execute chip erase automatically before performing the download. 
 
 

 
The supported file formats differ depending on the target CPU, etc. 
This software can be used for those supporting OBJECT. 

 

 Up to 1KByte of object data can be downloaded with the size limited version. 
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7.2.15. LOADPARAM (Supplement of LOAD Command Parameters) 
 
This command is used to supplement the parameters of LOAD command. 
 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 75 
 
●<Mode> 
 

Table 48 

CLEAR Initializes the parameter supplement data for the LOAD command. 

INQUIRY Not usable in this software. 

LOADLOCAL Not usable in this software. 

OFFSET Sets the offset value of the object data. If the module to be loaded is in binary 
format, the offset of LOAD command is used. The default <offset value> is 0. 

 
 
 
 

LOADPARAM CLEAR 

OFF LOADLOCAL 

<Command> <Mode> 

INQUIRY ON 

OFFSET <Offset value> 
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7.2.16. LOG (Control the Logging of the Command Window) 
 
This command is used to set whether to perform logging (saving to file) of the display contents in the 
Command window. 
The logging function saves the display contents after inputting ON or ADD to a file. 
 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 76 
 
●<Mode> 
 
Specify the recording mode. 
 

Table 49 

ON Starts logging by creating a new file. 

ADD Starts logging by adding the display contents to an existing file. 

OFF Ends logging. 
 
 
●<File name> 
 
Specify the name of the file to which log is saved. 
 
 

 
If you use the NEWBATCH command with this command, do not specify the same file for 
both commands. 

 
 
 
 
 

LOG ON 

OFF 

<Command> <Mode> 

ADD 

<File name> 

<File name> 
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7.2.17. MKDIR (Create a Folder) 
 
This command is used to create a folder in the specified path. 
This command has the same function as MKDIR command of DOS. 
 
●Format 
 
 
 
 
 
 

Figure 77 
 
●<Path name> 
 
Specify the path of a folder to create. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MKDIR <Path name> 

<Command> 
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7.2.18. NEWBATCH (Create a Batch File) 
 
This command is used to create a new batch file or add a batch file to the existing file. 
Commands that are input after the start of creation of a batch file by this command will be checked 
for parameters, but will not be actually executed. The character string in the command line will be 
saved in the file. 
Setting the OFF mode ends creation of batch file.  
 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 78 
 
●<Mode> 
 
Specify the recording mode. 
 

Table 50 

ON Creates a new batch file and start recording of commands. 

ADD Adds commands to the existing batch file and starts recording of commands. 

OFF Ends creation of a batch file. 
 
 
●<File name> 
 
Specify the name of a batch file that is newly created or to which commands are added. 
 
 

 
If you use the LOG command or the SAVEWIN command with this command, do not specify 
the same file for both commands. 

 
 
 
 
 
 
 
 
 
 
 
 

NEWBATCH ON 

OFF 

<Command> <Mode> 

ADD 

<File name> 

<File name> 
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7.2.19. OPTION (Set Options of the Command Window) 
 
This command is used to set options of the Command window. 
When MORE is turned on, display of the list of command execution results temporarily stops each time 
the list exceeds a single screen. 
When MORE is turned off, all execution results are displayed without stopping. 
 
●Format 
 
 
 
 
 
 
 
 
 
 
 

Table 51 
 
●<Mode> 
 
Specify the MORE function when executing the commands. 
 

Table 52 

ENABLE Stops the result display temporarily when it exceeds a single screen. 

DISABLE Scrolls the result display without stopping when it exceeds a single screen. 
 
 
● Example 

>OPTION MORE DISABLE 

[DISABLE]  MORE CONTROL 

 
 
 
 
 

<Command> 

OPTION MORE ENABLE 

DISABLE 

<Setting> 
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7.2.20. QUERY (Refer to Various Setting Status) 
 
This command is used to refer to various status of settings. 
 
●Format 
 
 
 
 
 
 

Table 53 
 
●<Mode> 
Specify the type of modes to refer to. 
 

Table 54 

各種モード 説明 

ENV Refers to the current status of probe environment setting. This command has 
the same function as the following menu. 

Resource → Probe Environment 

FM Refers to the device information of SPI flash memory. 

LOAD Refers to the download list currently registered. This command has the same 
function as the following menu. 

Resource → Download 

LOADPARAM Refers to the setting that set in LOADPARAM command. 

RADIX Refers to the setting of input radix. 

OPTION Refers to the setting status of options of the current command window. 
 
 
 

QUERY <Mode> 

<Command> 
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7.2.21. RADIX (Set the Input Radix) 
 
This command is used to set the input radix. 
This setting does not affect the output radix. 
 
●Format 
 
 
 
 
 
 
 
 
 

Figure 79 
 
●<Radix> 
 
Specify if radix is input in decimal or hexadecimal. 
 

Table 55 

DECIMAL Input radix in decimal. 

HEX Input radix in hexadecimal. 
With this radix, it is not possible to input a decimal. To handle a decimal number, 
switch to decimal by the RADIX command. Also, when handling a hexadecimal 
number, be sure to append "0x" to the beginning of the numeric value. 

 
 

RADIX DECIMAL 

<Command> 

HEX 

<Radix> 
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7.2.22. SAVEWIN (Output the Command Window to File) 
 
This command is used to output the history of the Command window currently open to a file. 
Unlike LOG command, displayed contents of commands that have already been executed are saved. 
 
 
●Format 
 
 
 
 
 
 
 
 
 

Figure 80 
 
●<Mode> 

Table 56 

NEW Saves the history by creating a new file. 

ADD Saves the history by adding to the existing file. 
 
 
●<File name> 
 
Specify the name of the file to save. 
 
 
● Example 

>SAVEWIN NEW C:\SPI_Writer\test.log 

Log New <C:\SPI_Writer\test.log> 

 

>SAVEWIN ADD C:\SPI_Writer\test.log 

Log Add <C:\SPI_Writer\test.log> 

 
 

 
If you use the NEWBATCH command with this command, do not specify the same file for 
both commands. 

 

SAVEWIN NEW 

<Command> 

ADD 

<File name> 

<Mode> 
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7.2.23. SEARCH (Search Memory) 
 
This command is used to search the specified memory range for the specified data. 
After the command is executed, the execution result is displayed. 
This command has the same function as the following menu. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → Memory Search --- 

 
 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 81 
 
 
●<Address range> 

Table 57 

Start address Specify the start address of the range where memory is searched. 

Range length Specify the length from the start address in bytes. 

End address Specify the end address. 
 

SEARCH Start Address LENGTH 

TO 

Range length 

End Address 

DATA Data BYTE 

WORD 

LWORD 

<Mode> 

<Address range> 

<Search data> <Display Size> 

<Command> 

MODE MATCH 

NOMATCH 

< Search condition> 
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●<Search data> 
 
Specify the data to search memory for. 
To search for a character, enclose it with single quotation marks ('). 
To search for a character string, enclose it with double quotation marks ("). 
It is not possible to directly insert such characters as space character and tab character in the 
character string, but they can be specified in formats such as (\x20) and (\x09). 
 
 
●<Display size> 
 
Specify the size of memory search. 
When a character string is specified as a search data, the specified size becomes invalid and the 
search is conducted with the size of the character string. 
 

Table 58 

BYTE Conducts memory search by byte data. 

WORD Conducts memory search by word data. 

LWORD Conducts memory search by long word data. 
 
 
●<Search condition> 
 
Specify the search condition. 
MATCH search is performed by moving forward through addresses by one byte. 
NOMATCH search is performed from the <start address> by the search data size. 
 

Table 59 

MATCH Searches for data that match the search data. 

NOMATCH Searches for data that do not match the search data. 
It is not possible to specify a character string as search data. If a character string is 
specified, search is conducted assuming the data of the first single character of the 
character string is valid. 
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7.2.24. SHELLEXE (Execute a File) 
 
This command is used to execute the specified file. 
 
 
●Format 
 
 
 
 
 
 

Figure 82 
 
●<Path name> 
 
Specify the path of the file to execute. 
 
 
● Example 

>SHELLEXE C:\SPI_Writer\test.exe 

 
 

SHELLEXE <Path name> 

<Command> 
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7.2.25. UPLOAD (Upload the Object Data) 
 
This command is used to upload the specified object data. 
This command has the same function as the following menu. 
 
Tool button Operation on the menu bar Shortcut key 

--- Resource → Upload --- 

 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 83 
●<File name> 
 
Specify the name of the file to upload. 
 
●<Address range> 

Table 60 

Start address Specify the start address of the data to upload. 

Range length Specify the length from the start address in bytes. 

End address Specify the end address. 
 
●<Output format> 
 
Specify the output format. 

Table 61 

IHEX64K Outputs in Intel HEX 64K format. 

IHEX1M Outputs in Intel HEX 1M format. 

IHEX4G Outputs in Intel HEX 4G format. 

MHEX64K Outputs in Motorola HEX 64K format. 

MHEX16M Outputs in Motorola HEX 1M format. 

MHEX4G Outputs in Motorola HEX 4G format. 

SHF Outputs in Sophia high-speed download format. 

BINARY Outputs in binary format. 
 
 
 

UPLOAD File name Start 
address LENGTH 

<Command> 

Format 

<Type> 

TO Range 
length 

End 
address 

<Address range> 
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7.2.26. VERIFY (Set Verification) 
 
This command is used to enable or disable verification. 
This command has the same function as the following menu. 
 
Tool button Operation on the menu bar Shortcut key 

 Go → Verify (Compare when writing) --- 

 Go → Verify Only (Compare without writing) --- 

 
 
●Format 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 84 
 
●<Setting> 
 
Enable or disable verification. 

Table 62 

ON Set the verification setting to "Verify (Compare after writing)" or "Verify Only 
(Compare without writing)." 

OFF Disable the verification setting. 
 
 
●<Memory write> 
 
Specify "Verify" or "Verify Only." 
 

Table 63 

MEMORY_WRITE ENABLE Set "Verify (Compare after writing)." 

MEMORY_WRITE DISABLE Set "Verify Only (Compare without writing)." 
 
 
 
 

VERIFY OFF 

ENABLE 

DISABLE 

<Command> 

ON MEMROY_WRITE 

<Setting> 

<Memory write> 
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● Example 

>VERIFY ON MEMORY_WRITE DISABLE 

[ON        ] VERIFY 

[DISABLE   ] VERIFY WRITE 

 

>VERIFY ON MEMORY_WRITE ENABLE 

[ON        ] VERIFY 

[ENABLE    ] VERIFY WRITE 

 

>VERIFY OFF 

[OFF       ] VERIFY 
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8. Batch Functions 
This software allows the batch program to batch process all commands that can be executed in the 
command line. 
Also, it is possible to conduct execution control of batch program by using work variables, system 
variables, and the execution control functions. 
 
The batch functions execute the commands (commands, definitions of variables, etc) described in the 
batch file line by line. 
To execute a command, the new-line character needs to be inserted at the end of the line. 
 
The batch program of this software executes the next command without waiting for the result of the 
executed command. 
 
 
The Command window is equipped with the NEWBATCH command for facilitating creation of batch 
file as well as a function to save commands entered to the Command window in a batch file. 
 
A batch programs can also call other batch programs. Though the upper limit of nest is not set, 
nesting is restricted to the range of the Windows resource. 
 
 

 
Parameters can be omitted as on the command line, but its method slightly differs from that 
of the command line. 

 
 

 Commands are case insensitive. 
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8.1. Work Variables 
 
As work variables to be used in batch program, "batch argument" that is passed as a parameter 
when a batch program starts up, "local variable" that is valid only for a single batch program, and 
"global variable" that is valid for all batch programs are available. 
Figure 85 shows an image of the scope of variables. 
Batch argument is a global variable that can be referred to only. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 85 
 
 
●Usable work variables 

Table 64 

Types of variable Name and contents of variable Example 

Batch argument $0: character string of the whole command line 
$1 to $9: 1st to 9th batch arguments 

$0 

Global variable $ (character string beginning with an upper case alpha letter) $GLOBAL 

Local variable $ (character string beginning with a character other than 
upper case alpha letters) 

$local 

 
Valid characters that can be used for variable name are as follows: 
A to Z, a to z, 0 to 9, _ (underscore) 
 
 
● Example 

.$a=0x10  // Assigns 0x10 to local variable $a. 

.$abc=0x50  // Assigns 0x50 to local variable $abc. 

.$B0=[0x40000].W  // Assigns the word data in address 0x4000 to global variable $B0. 

if($001==0x1234)  // True when the value of local variable $001 is 0x1234. 

 
 
 

[Batch1] 
$aa=5 
$BB=10 
 
 
 
 
 
print $aa ← Displays "5" 
print $BB ← Displays "20" 
 
$0=100 ← Error (argument is for reference only) 

[Batch2] 
$aa=30 
$BB=20 
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8.2. Labels 
 
This function is used to define the labels that are used for branch destinations or the like in batch 
program. 
The label starts with colon (:) at the beginning of the line. 
Commands cannot be described on the label line. 
 
 
● Example 

:COME_HERE 
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8.3. Comment 
 
This is used to write comment lines in batch program. 
Specify a comment by inserting two slashes (//) in succession at the beginning or middle of the line. 
Characters after // are treated as a comment. 
Comment lines do not affect the execution of batch program. 
 
 
● Example 

// This is Comment Line 

if ($a==0x1234)   // if $a equals to 0x1234 

 
 

 

For the following commands, it is not possible to write a comment on the same line as the 
command (i.e., after the command). 
batch, dump, exit, mkdir, newbatch, option, search, upload 
 
For example, the following description causes an error. 
batch test.bat // comment 
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8.4. Operators Usable in Numeric Operation 
 
8.4.1. Operators 
 
Operators that can be used in numeric operation including address formula are shown in Table 65. 
 

Table 65 

Type Sign Meaning 

Algebraic operators + Addition 

 － Subtraction 

 * Multiplication 

 / Division 

 % Remainder 

Comparative 
operators 

== 
Equal to 

 != Not equal to 

 < Less than 

 > Greater than 

 <= Less than or equal to 

 >= Greater than or equal to 

Shift operators << Shift left 

 >> Shift right 

Logical operators && AND 

 || OR 

 & AND by bit 

 | OR by bit 

 ^ XOR by bit 

 ~ NOT 

Assignment 
operators = 

Assign right side to left side. (* Following assignment operators 
may also be used.) 
+=, -=, *=, /=, %=, <<=, >>=, &=, |= 

Others () Parenthesis 
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8.4.2. Priority and Evaluation Order 
 
The priority is almost the same as in C language, but assignment operators are unique. 
* Commas (,) in the operator column are delimiters. 
 

Table 66 

Operator Connection rule 

+ (sign), - (sign), ~, ! (same process as ~) From left to right 

*, *=, /, /=, %, %= From left to right 

+, +=, -, -= From left to right 

<<, <<=, >>, >>= From left to right 

<, <=, >, >= From left to right 

==, != From left to right 

&, &= From left to right 

^, ^= From left to right 

|, |= From left to right 

&& From left to right 

|| From left to right 
 
You can group formulas by using a parenthesis. 
For example, when conducting a bit test, you can enclose formulas with parentheses such as 
if((x&mask)==0). 
 
 

 You cannot insert a space character between an operator and a variable (or value). 
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8.5. Reading to SPI Flash Memory 
 
 

 For details, refer the “3.4. Reading SPI flash memoy." 
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8.6. Execution Control 
 
8.6.1. FOR, FBREAK, NEXT (Repetitive Execution with Counter) 
 
This is used to execute a series of commands from FOR line to NEXT line as long as the <conditional 
expression> is satisfied. 
When FBREAK is executed between FOR and NEXT, the program immediately gets out of the FOR-
NEXT loop. 
 
 
●Format 
 
FOR <work variable>=<initial value> TO <conditional expression> [STEP <step value>] 

Command.... 
[FBREAK] 

Command.... 
NEXT <work variable> 
 

Table 67 

Parameter Description 

<Work variable> Specify a counter variable for repetitive processing. 
Specify work variables from 52 work variables ranging from $A to $Z and 
from $a to $z. 
The work variable specified for NEXT must be the same work variable as 
specified for FOR. 

<Initial value> Specify an initial value to be set to work variable in signed integer. 

<Conditional 
expression> 

Specify a conditional expression for controlling repetitive processing. For 
conditional expression, the following can be used: 
 Operator 
 Work variable 
 Memory data 
 Numerical value 

<Step value> Specify a value to increment a work variable when a single repetitive 
processing has finished in signed integer. 
When STEP is omitted, "1" is assumed. 

 
● Example 

FOR $A=10 TO $A<100 STEP 10 

  IF $A==50 

    FBREAK 

  ENDIF 

  DUMP 0 LENGTH $A 

NEXT $A 
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8.6.2. WHILE, WBREAK, WEND (Repetitive Execution) 
 
These are used to repetitively execute a series of commands between WHILE and WEND while the 
<conditional expression> is true (i.e., other than 0). 
If <conditional expression> is false (0), loop is terminated. 
When WBREAK is executed between WHILE and WEND, the program immediately gets out of the 
WHILE-WEND loop. 
 
 
●Format 
 
WHILE <conditional expression> 

Command.... 
[WBREAK] 

Command.... 
WEND 
 

Table 68 

Parameter Description 

<Conditional expression> Specify a conditional expression for controlling repetitive processing. 
 
 
● Example 

.$A=0 

WHILE $A<100 

  IF $A==50 

    WBREAK 

  ENDIF 

  DUMP 0 LENGTH $A 

  .$A+=10 

WEND 
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8.6.3. GOTO (Unconditional Branch) 
 
This is used to branch the batch program to the <label> line. 
 
 
●Format 
 
GOTO <label> 
 

Table 69 

Parameter Description 

<Label> Specify the label name at the destination of branch in the batch program. 
 
 
● Example 

:LOOP 

  Command 

GOTO LOOP 
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8.6.4. IF, ELSEIF, ELSE, ENDIF (Conditional Judgment) 
 
These are used to execute commands up to ELSEIF, ELSE, or ENDIF line when <conditional 
expression> is true (i.e., other than 0). You can specify as many ELSEIFs as you like. 
 
 
●Format 
 
IF<conditional expression> 

Command.... 
[ELSEIF <conditional expression>] 

[Command....] 
[ELSE] 

[Command....] 
ENDIF 
 
 

Table 70 

Parameter Description 

<Conditional expression> Specify a conditional expression for controlling execution. 
 
 
● Example 

IF $A>$B 

  DUMP 0 LENGTH $A 

ELSEIF $A==$B 

  DUMP 0x10 LENGTH $A 

ELSEIF $A<$B 

  DUMP 0x20 LENGTH $B 

ELSE 

  DUMP 0x30 LENGTH $B 

ENDIF 

 
 



 

119 / 131 
Universal Probe Software Users Manual – SPI Writer 

 
8.6.5. END (Exit All Batch Programs) 
 
This is used to exit all batch programs including nested batch programs that are currently executed. 
 
 
●Format 
 
END 
 
 
● Example 

IF $A>$B 

  END 

ENDIF 
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8.6.6. QUIT (Exit Current Batch Program) 
 
This is used to exit the batch program that is currently executed. 
When the batch program is nested, only the current batch program is terminated and control returns 
to the calling source program. 
 
 
●Format 
 
QUIT 
 
 
● Example 

IF $A>$B 

  QUIT 

ENDIF 

 



 

121 / 131 
Universal Probe Software Users Manual – SPI Writer 

 

8.7. ECHO (Switch Show/Hide of Batch Commands) 
 
This is used to switch between displaying and hiding commands in batch program. 
 
 
●Format 
 
ECHO {ON|OFF} 
 
 
● Example 

IF $A>$B 

  ECHO ON 

ELSE 

  ECHO OFF 

ENDIF 
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8.8. KEYIN (Input from the Keyboard) 
 
If <character string> is specified, <character string> is displayed in the status bar of the command 
window as a guide character string and the program waits for input from the keyboard. When a work 
variable is specified, this command assigns the character string input from the keyboard to a work 
variable. 
 
Input of character string from the keyboard is terminated once the Return character (Enter) is input. 
 
When both of <character string> and <work variable> are not specified, the input character string is 
evaluated as a formula and the evaluation result is displayed. 
At this point, if an assignment formula or the like is specified, the result of the formula on the right 
side is assigned to the formula on the left side. 
 
 
●Format 
 
KEYIN [<character string> [<work variable>]] 
 

Table 71 

Parameter Description 

<Character string> Specify the guide character string that is displayed in the status bar of the 
Command window. 

<Work variable> Specify the work variable to set a value that is input from the keyboard. 
 
 
● Example 

KEYIN "A=" $A  // Displays "A=" in the Command window and waits for key input. 
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8.9. PRINT (Display the Character String) 
 
This command is used to evaluate the specified <numeric expression> and display it in the Command 
window in the format specified by <format> . 
When <character string> is specified, it is displayed in the Command window before <numeric 
expression> is displayed. 
As many <character string> and <numeric expression> parameters as you like may be specified by 
separating them with a space character. 
 
 
●Format 
 
PRINT {[<character string>] [<numeric expression>][<Format>]} + 
 

Table 72 

Parameter Description 

<Character string> Specify the guide character string that is displayed in the command window. 
<Numeric expression> Specify the work variable to set a value that is input from the keyboard. 
<Format> Specify the format in which numeric expression is displayed. 
 
●<Format> 

Table 73 

Format Description 

None Default display format. Displays a 4-byte hexadecimal value and a signed 
decimal value enclosed in parentheses. 

.#B Displays in 2-byte binary value. 

.#LB Displays in 4-byte binary value. 

.#D Displays in 2-byte signed decimal value. 

.#LD Displays in 4-byte signed decimal value. 

.#U Displays in 2-byte unsigned decimal value. 

.#LU Displays in 4-byte unsigned decimal value. 

.#H Displays in 2-byte hexadecimal value. 

.#LH Displays in 4-byte hexadecimal value. 
 
● Example 

PRINT "abcdefg" 

    abcdefg     // Execution result 

PRINT "$A=" 1+2+3 " $B=" 1*2*3 

    $A=0x00000006 (6) $B=0x00000006 (6)   // Execution result 

.$A=0xffffffff 

PRINT "$A=" $A 

    $A=0xffffffff (-1)     // Execution result 

PRINT "$A=" $A.#B 

    $A=1111 1111 1111 1111    // Execution result 

PRINT "$A=" $A.#LB 

    $A=1111 1111 1111 1111 1111 1111 1111 1111 // Execution result 



 

124 / 131 
Universal Probe Software Users Manual – SPI Writer 

 

8.10. BEEP (Beep) 
 
This is used to beep. 
 
 
●Format 
 
BEEP 
 
 
● Example 

IF $A > $B 

  BEEP 

ENDIF  

 
 

 To beep, you need to set "Normal Beep" in the Sound Scheme setting of Windows. 
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8.11. WAIT (Stop a Batch Program Temporarily) 
 
This command is used to stop a batch program for the specified seconds. 
 
 
●Format 
 
WAIT <seconds> 
 
 

Table 74 

Parameter Description 

<seconds> Specify the time in seconds for which the batch program is stopped. 
 
 
● Example 

IF $A > $B 

  WAIT 10 // Waits for 10 seconds. 

ENDIF 
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9. Stand-alone Functions 
The stand-alone action records written data and writing procedure in a probe and executes recorded 
procedure later by itself by pressing the RUN button of the probe while power is supplied, even not 
connected to a host PC. 
 

1) Recording of written data and writing procedure 
 

Connect to the host PC and perform data write to the target in normal procedures. 
At this point, record the written data and the writing procedure in the probe. 

 
 
 
 
 
 
 
 
 
 
 

Figure 86 
 
 

2) Disconnect the probe from the host PC 
 

Disconnect the probe from the host PC and connect with the target. 
 
 
 
 
 
 
 

Figure 87 
 
 

3) Connect with power supply and press RUN button 
 

Supply power from a rechargeable battery, for example, and after confirming that the 
POWER LED of the probe is lit, press the RUN button. 

 
 
 
 
 
 
 
 
 
 
 

Figure 88
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4) Perform writing 
 

During writing, the STATUS LED blinks. 
 
 
 
 
 
 
 
 
 
 

Figure 89 
 
 

5) When writing ends, the LED indicates the result of writing 
 

When writing finishes normally, the STATUS LED lights in green and when the writing failed, 
the ERROR LED lights in red. 
 

 
 
 
 
 
 

 
 [When finished normally] [When failed] 
 

Figure 90 
 

 
 

Target 

 

Write 
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9.1. Recording of Procedure 
 
When this software starts, the following screen is displayed. 
If the button indicated by a red-line circle below is clicked, the mode changes to the mode for 
recording the operation procedure. 
Open (or create) a project file in this condition and execute writing to SPI flash memory once. 
 

 

Figure 91 
 
 
During recording, "Short-press recording" is displayed in the window title bar. 
 

 
Figure 92 

 
 

9.2. End of Recording 
 
To end recording, exit this software or close the project. 
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9.3. Backup and Restoration of Recorded Procedure 
 
You can back up the recorded procedure in the host PC. 
You can also restore the backed up procedure. 
Procedure can be restored to other probes as well. However, if the License Code of this software is not 
registered in the restoring probe, pressing the RUN button causes an error. 
 

 
Figure 93 

 
 

Table 75 

Menu Description 

Start Short-press 
Recording 

When this menu is selected, the mode changes to the step recording 
mode. 

Upload Probe Memory Uploads (backs up) the procedure recorded in the probe to the host PC. 

Download Probe Memory Downloads (restores) the procedure uploaded (backed up) in the host PC 
to the probe. 

 
 
 

 

The stand-alone function and the procedure backup/restoration function are convenient in 
the following cases: 
 Writing is performed in parallel in the factory. 
 The contents of memory are frequently restored due to maintenance and repair. 
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Ver. No. Revision date Content of revision 
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02 11/17/2014 Correction of typographical errors. 
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